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COURSE OUTCOMES (CO’s) 

 Disassemble and Assemble a Personal Computer and prepare the computer ready to use.   

 Prepare the Documents using Word processors and Prepare spread sheets for calculations using 

excel and also the documents using LAteX.   

 Prepare Slide presentations using the presentation tool. 

 Interconnect two or more computers for information sharing. 

 Access the Internet and Browse it to obtain the required information.  
 

PROGRAMME EDUCATIONAL OBJECTIVES (PEOs) 

PEO-1: To strengthen the learners with fundamental concepts of mathematics, applied sciences 
and basic engineering subjects to analyze and solve problems in Computer Science and 
Engineering. 

PEO-2: To produce academically strong and technically sound graduates with core instruction, 
innovative design competence, development and testing skills for offering solutions to 
real world problems using modern tools and techniques. 

PEO-3: To make the learners competent in advanced computer programming languages to 

become efficient professionals to sustain life long career. 

PEO-4: To support the learners with Training, Placement, Career Guidance and Research with 
multidisciplinary approach, professional ethics, leadership qualities and good 
communication skills. 

PROGRAM OUTCOMES (POs) 

 

PO-1 
Engineering knowledge: Apply the knowledge of mathematics, science, engineering 
fundamentals, and an engineering specialization to the solution of complex 
engineering problems. 

PO-2 
Problem analysis: Identify, formulate, review research literature, and analyze 
complex engineering problems reaching substantiated conclusions using first 
principles of mathematics, natural sciences, and engineering sciences. 

PO-3 
Design/development of solutions: Design solutions for complex engineering 
problems and design system components or processes that meet the specified needs 
with appropriate consideration for the public health and safety, and the cultural, 
societal, and environmental considerations. 

PO-4 
Conduct investigations of complex problems: Use research-based knowledge and 
research methods including design of experiments, analysis and interpretation of 
data, and synthesis of the information to provide valid conclusions. 



 

 

PO-5 
Modern tool usage: Create, select, and apply appropriate techniques, resources, 
and modern engineering and IT tools including prediction and modeling to 
complex engineering activities with an understanding of the limitations. 

PO-6 
The engineer and society: Apply reasoning informed by the contextual knowledge 
to assess societal, health, safety, legal and cultural issues and the consequent 
responsibilities relevant to the professional engineering practice. 

PO-7 
Environment and sustainability: Understand the impact of the professional 
engineering solutions in societal and environmental contexts, and demonstrate the 
knowledge of, and need for sustainable development. 

PO-8 
Ethics: Apply ethical principles and commit to professional ethics and 
responsibilities and norms of the engineering practice. 

PO-9 
Individual and team work: Function effectively as an individual, and as a member or 
leader in diverse teams, and in multidisciplinary settings. 

PO-10 
Communication: Communicate effectively on complex engineering activities with 
the engineering community and with society at large, such as, being able to 
comprehend and write effective reports and design documentation, make effective 
presentations, and give and receive clear instructions. 

PO-11 
Project management and finance: Demonstrate knowledge and understanding of 
the engineering and management principles and apply these to one’s own work, as a 
member and leader in a team, to manage projects and in multidisciplinary 
environments. 

PO-12 
Life-long learning: Recognize the need for, and have the preparation and ability 
to engage in independent and life-long learning in the broadest context of 
technological change. 

PROGRAM SPECIFIC OUTCOMES (PSOs) 

 
PSO-1 Responsive to Ideas: Get an employment in Computer Science and Engineering field 

and related software industries or become an entrepreneur in the domains such as 
DBMS, Java, Networking, IOT, Mobile Computing, Artificial Intelligence and Cloud 
Computing. 

PSO-2 
Domain Knowledge: Get qualified in competitive exams to Pursue Higher Education 

through the knowledge attained in advanced programming languages like Java, Machine 

Learning, PHP, Python, Android Studio, Hadoop Framework, AWS, R and Weka etc. 
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GENERAL INSTRUCTIONS FOR LABORATORY CLASSES 

 
DO‘S  

1. Without Prior permission do not enter into the Laboratory.  

2. While entering into the LAB students should wear their ID cards.  

3. The Students should come with proper uniform.  

4. Students should sign in the LOGIN REGISTER before entering into the laboratory.  

5. Students should come with observation and record note book to the laboratory.  

6. Students should maintain silence inside the laboratory.  

7. After completing the laboratory exercise, make sure to shutdown the system properly  

 

 

DONT‘S  

 

8. Students bringing the bags inside the laboratory.. 

9. Students wearing slippers/shoes insides the laboratory.  

10. Students using the computers in an improper way.  

11. Students scribbling on the desk and mishandling the chairs.  

12. Students using mobile phones inside the laboratory.  

13. Students making noise inside the laboratory.  
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TASK 1 

Aim: To Identify The Internal Parts of a Computer 

Computer : Computer is a device that transforms data into meaningful information. Data can be 

anything like marks obtained by you in various subjects. It can also be name, age, sex, weight, height, 

etc. of all the students in a class. Computer can also be defined in terms of functions it can perform. A 

computer can i) accept data, ii) store data, iii) process data as desired, and iv) retrieve the stored data 

as and when required and v) print the result in desired format. The major characteristics of a computer 

are high speed, accuracy, diligence, versatility and storage. 

                   The computer performs basically five major operations of functions irrespective of their 

size and make. These are 1) it accepts data or instruction by way of input, 2) it stores data, 3) it can 

process data as required by the user, 4) it gives results in the form of output, and 5) it controls all 

operations inside a computer.  

We discuss below each of these operations. 

 

 
 

1. Input unit : this is the process of entering data and programs into the computer system 

 

2. Control Unit (CU): The process of input, output, processing and storage is performed under the 

supervision of a unit called 'Control Unit'. It decides when to start receiving data, when to stop it, 

where to store data, etc. It takes care of step by-step processing of all operations inside the computer. 

 

3. Memory Unit: Computer is used to store data and instructions. 

 

4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, 

subtraction, multiplication, division, logic and comparison. 
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5. Output: This is the process of producing results from the data for getting useful information. The 

ALU and the CU of a computer system are jointly known as the central processing unit (CPU). You 

may call CPU as the brain of any computer system. 

 

PERIPHERAL DEVICES: Peripheral devices are connected to the computer externally. These 

devices are used for performing some specific functions. 
Peripheral devices are as follows: 

1. Input Devices 

2. Output Devices 

3. Other Peripherals 

 

1. INPUT DEVICES: Input devices accept data and instructions from the user. 
Following are the examples of various input devices, which are connected to the computer for this 

purpose. 

1. Keyboard 

2. Mouse 

3. Light Pen 

4. Optical/magnetic Scanner 

5. Touch Screen 

6. Microphone for voice as input 

7. Track Ball 

 

1. Keyboard: A keyboard is the most common input device. Several kinds of keyboards are 

available, but they resemble each other with minor variations. The keyboard in most common use is 

the QWERTY board. Generally standard keyboard has 104 keys. In these keyboards, the cursor 

control keys are duplicated to allow easier use of the numeric pad. 
 

                                                                         
 

2 .Mouse: A mouse is an electro-mechanical, hand-held device. It is used as a pointer. It can 

perform functions like selecting menu commands, moving icons, and resizing windows, starting 

programs, and choosing options. 
                 The most common mouse uses an internal, magnetically coated ball, to detect the 

movement of the mouse across a flat surface, usually a desktop. Now a days Optical or laser mouse is 

used to detect the movement. All windows based applications today are designed to work with a 

mouse. A mouse is used to replace hard-to-remember key combinations with easier "Point and Click" 

actions. However, it cannot substitute all keyboard operations. It can be alternative for commands 

based operations. 
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3. Light pen: An input device that utilizes a light-sensitive detector to select objects on a display 

screen. A light pen is similar to a mouse, except that with a light pen you can move the pointer and 

select objects on the display screen by directly pointing to the objects with the pen. 
 

 

 

 

                                                                               
                                                                                                                    Light pen 

 

4 .Optical Scanner: These devices are used for automatic data collection. The devices of this 

category completely eliminate manual input of data. For example, the bar-code reader is actually just a 

special type of image scanner. An image scanner translates printed. 
 

 

                                                                     
 

5. Touch Screen: Touch panel displays and pads are now being offered as alternatives to 

keyboard. Here the input can be given through the computer screen, that accepts the input through 

monitor; users touch electronic buttons displayed on the screen or they may use light pen. 
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6. Microphone: Microphone is an input device, which takes voice as input. The voice 

communication is more error-prone than information through keyboard. There are two types of 

microphones available 
 

   

                                                              
 

 

 

7 .Track Ball: Trackball, a pointing device, is a mouse lying on its back .To move the pointer; you 

rotate the ball with your thumb, your fingers, or the palm of your hand. There are usually one to three 

buttons next to the ball, which you use just like mouse buttons. The advantage of trackballs over 

mouse is that the trackball is stationary so it does not require much space to use it. In addition, you 

can place a trackball on any type of surface, including your lap. For both these reasons, trackballs are 

popular pointing devices for portable computers. 
 

                                                              
 

2. OUTPUT DEVICES: Output devices return processed data that is information, back to the 

user. Some of the commonly used output devices are: 
1. Monitor (Visual Display Unit)    2. Printers 

3. Plotter                                      4. Speakers 

 

1 .Monitor: Monitor is perhaps the most important output device because people interact with this 

device most intensively than others. Computer information is displayed, visually with a video adapter 
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card and monitor. Information processed within the CPU, that needs to be visually displayed, is sent to 

video adapter. The video adapter converts information from the format used, in the same manner as a 

television displays information sent to it by a cable service. 

                                                    
                                                               

 

Two basic types of monitors are used with microcomputers, 

which are as follows: 

1. CRT 

2. LCD 

1. Cathode Ray Tube (CRT): CRT or Cathode Ray Tube Monitor is the typical monitor that 

you see on a desktop computer. It looks a lot like a television screen, and works the same way. This 

type uses a large vacuum tube, called cathode ray tube (CRT).Liquid Crystal Displays  

 

                                                                 
                                                                                          

2. (LCD): This type of monitors is also known as flat panel monitor. Most of these employ liquid 

crystal displays (LCDs) to render images. These days LCD monitor are very popular. When people 

talk about the capabilities of various monitors, one critical statistic is the resolution of the monitor. 

Most monitors have a resolution of at least 800 x 600 pixels. High-end monitors can have resolutions 

of 1024 x 768 pixels or even 1280 x 1024pixels. Thus monitors are available either in low resolution 

or in high resolution. 
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2 .Printers: After a document is created on the computer, it can be sent to a printer for a hard copy 

(printout). Some printers offer special features such as colored and large page formats. Some of the 

most commonly used printers are: 
1. Laser Printer 

2. Ink Jet Printer 

3. Dot Matrix Printer 

4. Line Printer 

1. Laser Printer: A laser printer produces high quality print that one normally finds in publishing. It is 

extremely fast and quiet. Moreover, the operation of a laser printer is easy with automatic paper 

loading and no smudging or messing up of ink ribbons. The fastest laser printer can print up to 200 

pages per minute in monochrome (black and white) and up to 100 pages per minute in color. 

 

                                                      
 

 

 

2. Ink-Jet Printer: An ink-jet printer creates an image directly on paper by spraying ink through 

as many as 64tiny nozzles. Although the image it produces is not generally quite as sharp as the output 

of a laser printer, the quality of ink-jet images is still high. In general, ink-jet printer offers an 

excellent middle ground between dot matrix and laser printer. Like laser printer, an ink-jet printer is 

quiet and convenient, but not particularly fast. Typically, an ink-jet printer is more expensive than a 

dot-matrix printer, but costs only half as much as a laser printer. 

                                              

                                                                
3. Dot Matrix Printer: The dot matrix printer was very popular at one point of time. It is a very 

versatile and inexpensive output device. In dot matrix printer the print head physically "hits" the paper 

through the ribbon and produces text (or images) by combinations of dots; hence the name dot matrix 

printer. Its speed is measured in characters per second (CPS). Although it is less expensive, it is 

louder, slower and produces lower print quality. 
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4. Line Printer: A line printer is generally used with large computer systems to produce text based 

data processing reports. Line printers are high-speed printers with speeds ranging anywhere from 100 

to about 3800 lines per minute. In the past, print quality on line printers was not high. Developments 

in technology are improving the print quality on line printers. These are in the cost range of lakhs of 

Rupees. 

                                                                 

                 

                   

                                    
 

 

3. Plotter: A plotter is a special kind of output device that, like a printer, produces images on paper, 

but does so in a different way. Plotters are designed to produce large drawings or images, such as 

construction plans for buildings or blueprints for mechanical objects. A plotter can be connected to the 

port normally used by a printer. An array of different colored pens in a clip rack and a robotic arm is 

part of plotter. The instructions that a plotter receives from a computer consist of a color, and 

beginning and ending coordinates for a line. With that information, the plotter picks up the appropriate 

pen through its arm, positions it at the beginning coordinates drops the pen down to the surface of the 

paper and draws to the ending coordinates. Plotters draw curves by creating a sequence of very short 

straight lines. 
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4. Speakers: Speakers are another type of output device, which allow you to listen to voice like 

music, and conversation with people. 

 

 

                                                  
 

Parts Of Central Processing Unit: 

1.Motherboard: It is a printed circuit that is the foundation of a computer and allows the CPU, 

RAM, and all other computer hardware components to function with each other. 

                                          

 

2.Processor/CPU: It was first developed by Intel in 1974. Unit. The computer CPU is responsible 
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for handling all instructions and calculation it receives from other hardware components in the 

computer and software programs running on the computer.  

                                                      

                            

3.Hard drive: Hard drive is a Computer's main storage media device also called a hard disk drive 

or abbreviated as HD or HDD.  

                       

                                                             

4.Memory/RAM: Ram is a term commonly used to describe the memory within a computer. 
RAM (Random Access Memory) is the internal memory of the CPU for storing data, program, and 

program result. It is a read/write memory which stores data until the machine is working. As soon as 

the machine is switched off, data is erased. 
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5.CD/DVD ROM Drives: CD-ROM drives are CD-Players inside computers that has the 

capability of playing audio CDs and computer data CDs. DVD-RW Drive is a technology that enables 

a user to read and write to a DVD+RW or DVD+R disc several times. 

 

                                                         

6. Power Supply: The PS is an internal hardware component used to supply the components 

within the computer with power. Besides properly supplying power to the computer and all its internal 

components, the power supply also converts the AC electrical current found in most standard wall 

sockets throughout the United States into a lower DC voltage that the computer components use. 

                                                

7.Sound Cards: It is Also known as a sound board or an audio card, a sound card is an expansion 

card or integrated circuit that provides a computer with the ability to produce sound that can be heard 

by the user. 
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8.Video/Graphic: Cards also known as a graphics card, video card, video board, or a video 

controller, a video adapter is an internal circuit board that allows a display device, such as a monitor, 

to display images from the computer 

DIAGRAMS OF PARTS OF COMPUTER 
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DIAGRAMS OF PARTS OF CPU 

 

 

PARTS OF MOTHER BOARD 
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TASK 2 

 Every student should disassemble and assemble the PC back to working condition.  

AIM: To assemble and disassemble the system 

Why should one learn about hardware? 

1. Troubleshoot yourself and save time. 

2. Knowing about system internals and components. 

3. Very easy installation for modern hardware. 

4. Install extra memory. 

5. Removing components. 

Safety Precautions: 

1. Beware of electrostatic discharge (ESO) 

2. Build computer on a hard surface, away from concepts. 

3. Wear shoes and the short sleeved cotton wear. 

4. Use Phillips, head screw driver. 

5. Keep the components away from moisture. 

6. Avoid using pressure while installing. 

Steps for Assembling: 

1. Setting the cabinet ready. 

2. Preparing to fit the components. 

3. Fitting the mother board. 

4. Fitting the RAM, processor and cooler. 

5. Installing PCI cards. 

6. Fitting the hard disk and floppy drive. 

7. Installing the CD ROM drives. 

8. Connecting the ribbon cables. 

9. Powering the drives and mother board. 

10. Connecting the cables for the case front panel. 

11. Final check. 
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Getting the Cabinet ready:- 

1. Check how to open the cabinet and determine where to fix the components. 

2. Determine if the case has the appropriate risers installed. 

Preparing to fit the Components: 

1.  Network adapter drive. 

2.  Floppy disk drive. 

3.  Ribbon cables. 

4.  Hard disk. 

5.  CD-ROM Drive. 

6.  RAM 

7.  CPU 

8.  Heat sink / cooler / fan. 

9.  Mother board. 

10.  Screws. 

Fitting the Mother board. 

1. Line up the patch on the motherboard ( ps/l, USB, etc ) with the appropriate holes in the 

block panel I/O shield of the case. 

2. Check the points where you and to install 

3. Install them and make the mother board sit on them and fix screws if required. 

 

Mother board parts: 

1. ACR slot. 

2. PCI Slot. 

3. AGP Slot. 

4. ATX Connectors. 

5. CPU Fan. 

6. Chipset North Bridge. 

7. CPU socket. 

8. Floppy. 

9. System memory. 
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10. Chipset south bridge. 

11. Panel connector. 

12. Power supply. 

13. IDE connectors. 

            

ATX Connectors: 

1. PS, Mouse. 

2. Key board. 

3. USB. 

4. Parallel ( Prints ) 

5. Serial COM1. 

6. Serial COM 2. 

7. Sound. 

Fitting the processor: 

   1. Raise the small lever at the side of the socket. 

 2. Notice that there is a pin missing at one corner, determine the direction       

     to fit in the processor. 

3. You should not force the CPU. When inserting it. All pins should slide smoothly into the 

socket. 

4. Lock the lever back down. 

5. Install the heat sink over it (Different type for each processor). Heat sink / CPU fan.  

 Fitting the RAM: 

1. The RAM must be suitable for motherboard. 

2. There are currently 2 types of RAM available. 

a) SD RAM. 

b) DDR RAM. 

3. The mother board’s chipset determines which type of  RAM may be used. 
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Installing the PCI Cards: 

1. Most of the cards are inbuilt these days. 

2. NIC, Sound Cards etc. are fitted into PCI slots. 

Fitting the hard disk and Floppy disk: 

1. Place the floppy and hard disks in their slots. 

2. Leave some space above HDD to prevent heat building. 

3. Check the jumper configuration. 

4. Fix the screws. 

Installing the CD-ROM Drives: 

1. CD-ROM drive is similar to installing a hard disk. 

2. 1ST check that the jumper configuration is correct. 

3. Fix the screw. 

Connecting the Ribbon Cables:- 

1. Attach the long end of the cable to the IDE connector on the motherboard first. 

2. The red stripe on the IDE cable should be facing the CD Power. 

Powering the driver and motherboard: 

 Connecting the cables for the case front panel 

        1. SD, SPK or SPEAK: The loud speakers o/p. it has 4 pins. 

        2. RS, RE, RS or RESET: Connect the two pin Reset cable here. 

        3. PWR, PW, PWSW, PS or power SW: Power switch, the pc’s on (switch, the plug is two pin). 

        4. PWLED, PWRLED or Power LED: The light emitting diode on the front Panel of the case 

illuminates when the computer is switched on. It’s a 2- Pin cable. 

       5. HD, HDD, and LED: These two pins connect to the cable for the hard disk Activity LED. 

Final Check:- 

Mother board jumper configurations are the settings for the processor operator. 

1. Drive jumper settings, master/ slave correct? 
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Placing the mother board in the Cabinet 

Raising lift lever on the CPU Socket 

2. Are the processor, RAM modules and plug in cards finally seated in there sockets? 

3. Did you plug all the cables in? Do they all fit really? 

4. Have you frightened all the screws in plug- in cards or fitted the clips? 

5. Are the drive secure? 

6. Have you connected the power cables to all drivers? 

Powering up for the first time: 

1. Ensure that no wires are touching the CPU heat sink fan. 

2. Plug your monitor, mouse and keyboard. 

3. Plug in power card and switch the power supply. 

4. If everything is connected as it should be 

• All system, fans should start spinning. 

• U should hear a single beep and after about 5-10 sec. 

• Amber light on monitor should go green. 

• You will see computer start to boot with a memory check. 

• Now check front LED’S to see if u plugged them in correctly. 

• Check all other buttons. 

• Power afford change any wrong settings.         
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        Placing the CPU in to the Socket       

 

 

              

                                                                    Placing the Heat Sink 

 

 

 

                                                    Inserting the RAM (Memory Chip) into the RAM Slots 
 

                     

 

Back Side of the Hard Disk 
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TASK 3 

Every student should install Linux on the computer .This computer should have windows 

installed. The system should be configured as dual boot with both windows and Linux.  

AIM: Perform the installation of the Linux operating system on a personal Computer which 

should be windows installed. The system should be configured as the dual boot with both 

windows and Linux 

PROCEDURE: YaST (Yet another Setup Tool) provides options that make installation simple 

and quick.  To perform the installation, follow the steps: 

1. Insert the  SUSE  Linux  Enterprise  Server  10  Product  CD/DVD and then reboot 

the system to start installation program. 

2. Now it will display the Boot options window to select one option using the arrow 

keys. Now select the “Installation” option from Boot options window which will starts normal 

installation process where all modern  hardware  functions  are  enabled. 

 

 

 

 

 

 

 

 

 

3 .Next you will be asked for system language selection which is started  by  the  YaST. 
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The left side display the overview of installation status. The right side displays the current 

installation step. 

4.After selecting the language click on next to accept the license agreement. There you 

have to select the option  “Yes, I agree to  the License greement”. 

5. After accepting the license agreement, in the Installation Mode dialog select either 

“New Installation” or “Update” (or) select “Repair Installation” or “Boot Installed 

System” from the Other Options dialog. 
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6After selecting the New Installation option from the installation mode now set/change 

clock and time zone. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Next is to click on accept button to understand & change the installation settings. 

Booting is one of the installation settings, Select this if you want to change  any  boot  
loader  settings  or  use  Lilo  (Linux  Loader)  instead  of  GRUB (Grand  Unified  Boot  loader)  
as  boot  loader. 

 

installation settings. 

 

 

 

installation settings. 
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   Primary Partition” consists of a continuous range of cylinders (physical disk areas) assigned to  
a  particular  file  system.  If  you  use  only  primary  partitions, You are   limited to four partitions per 
hard disk.This is why extended partitions are used.  “Extended Partitions” are also continuous ranges of 
disk cylinders, but can be subdivided into “Logical partitions” which do not require entries in 
the main partition table. 
 

 Installation needs  at  least  two  partitions: 

Swap partition: This partition is used by Linux to move unused data from the main 

memory to the hard dive, thus freeing  main  memory which then can be used by other 

processes. 

Root partition: This is the partition that holds the top (/) of the file system 

hierarchy, called as root directory. 

 

8.Next it will be asked to create the partition, select the type of partition from the 

Partitioning headline in the installation proposal Where we have three options accept 

Proposal (accepts already existing partition  scheme,  Base  Partition  Setup  on  This  Proposal  

(Starts  the  YaST Expert   Pratitioner),   and   Create   custom   Partition   Setup   (used   to   create 

custom  partition). 

 

   

   
 

 

 

 

 

 

 

 

9.After selecting Create Custom partition setup option it  will  display a dialog of Hard 

disk containing two options. Select the option. “Custom.  Partition  (for  experts)”. And  

click  on  Next  button.  

10.Create  new  Partition  by  clicking  the  create  button  and  choose “create  a  primary  or 

logical partition”.And select the start and end cylinder and file system and mount point and 

click on OK. 
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11) 

Preparing Hard Disk: Step1                                                                       Expert Pratitioner 

 
 

 

11.Next you will be asked to select the software depending  on  the  disk space available. 
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12. Next we can start the installation process by clicking the accept button, which shows the 

dialog asking you to confirm the proposal. 

13. Start the installation by selecting the option “Install”. 

14. Set the host name of the system to “Linux”, root password (let the root password be 

linux). 
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15.Next is to either skip configuration or use the following configuration.  Let  here  we  select  
“skip  configuration”.  
 

 

 

 

 

 

 

 

 

16. Next it  will  ask  to  test  the  internet  connection. As  we  don’t  have the internet connection 

we just skip this test To skip this we select the  option  “No,  Skip  This  Test”. 

17. Next you will be asked to manage the users. Where we can add the local users. To add 

local users we have to give the full name of the user, user name, and password and confirm 

password and click on next button. 

 

 

 

 

 

 

 

 

18.Next you will bw asked to configure the hardware. The configuration proposal contains the Graphic 

card printer,and sound option to configure. 
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19. Confirm your hardware settings by selecting next, and then select Finish. 

20. The system starts the graphical login screen, where you can login with your previously 

created user  account.  SLES 10  is  now installed on your system. 

21. To Login enter the user name and password which is entered in step number 17. 

Result: I  have  successfully  completed  Linux  Installation  on  a  personal  computer. 

F AT 

NTFS      

BIOS 
Commands: 

→ 

 → 
→ 

File 

Basic 

location Table 

New Technology File System 

Input Output System 

mkdir 

cd 

ls 

mv 

cat 

cp 

date 

time 

cal 

→ create 

→ 

→ 

→ 

→ 

→ 

→ 

→ 

→ 

a directory 

change the directory 

display  list  of  files  &  directories 

move or rename 

create a file 

copy the contents of one file to other 

display the date 

display the system, real, user time 

display the calendar 
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WINDOWS XP INSTALLATION: 

AIM: Perform the installation of Microsoft Windows XP on a Personal Computer. 

 

Procedure:  Windows XP is one of the versions of Microsoft which was made 

publicly available  on  October  25th,  2001.  Two editions  available  are  “Windows XP 

HOME Edition” and “Windows XP Professional”. The word XP originate from the 

word “Experience”. 

Steps to Install Windows XP: 

 
1. Insert the Windows XP CD- ROM and reboot the Computer. Now 

Press either  “Del” or  “function  key” mentioned  in  the  initial  screen  
to  move  in to the  Advance BIOS Features Window. 

2. Change  and  save  the  Boot  Device  priority  such  that  give  the  first  

boot priority to CD - ROM and give the second boot priority to 

Hard Disk Drive (HDD0). 

3. Now the system will restart automatically and will boot from CD 

while booting  from  CD  it  will  check  for  the  system’s  hardware  

configuration. 

4. Now it will ask for “to setup windows XP” or “to repair Windows 

XP”or to quit from the setup (F3). This is as shown in the figure- 1.  

(Shows the Setup window). 
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5.After pressing “Enter” key to setup the windows XP we have to accept the  license  

agreement  called  as  EULA(End  User  License  agreement). To accept the license agreement press 

F8. 
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6. Next we are taken to a menu that allows us to partition the new hard  drive. Keys used 

throughout the XP installation is “F3”, “F8”, “D”, “C”, “R” and “Enter” where F3 is a function 

key to quit, F8 is also a function key to agree. The license, D is a normal key used to delete the 

partition, C is used to create      the partition, R is used to repair XP installation and  Enter  key  is  

used  to continue. 

 

7. After creating the partitions now we have to choose the file system the newly created partition 

before formatting. The file System may be NTFS (New Technology File System) or FAT(File 

Allocation Table). 
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NTFS  allows  us  to  make  larger  partitions  and  is  superior  to FAT There  are two  versions  of 

FAT. They are FAT 16 AND FAT 32. 

8. To select NTFS now press  Enter  key. Now formatting of the partition   is started which 

shows the formatting progress status bar. 

 

 

 

 

 

 

 

 

The format program will also ask if you want to do a quick format or a full format.  Select 

Full  format  (recommended  by  Windows). 

9.After  formatting  is  completed  it  will  copy  all  the  operating  system  files from the CD to 

hard drive. Then the system will reboot and continue installation process. 

10.After  rebooting  the  system  it  will  ask  to  enter  the  regional  and  language settings 
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11. Next you will be asked to enter your name to personalize your software. 

 

 

 

 

 

 

 

 

 

 

12. Next you will be asked to enter the product key, which is a 25 character key. 

13. Next you will be asked to enter the name of the computer. This is useful on  a 

network 
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14. Next you will be asked to enter the date and time settings 

 

 

 

 

 

 

 

 

 

 

15.Now  it  will  copy  the  remaining  files  to  hard  drive.  You can  see  the progress of 

the install by the status bar at the left of the screen 

16. Next it will be asked to activate the windows. This is possible if you have the 

internet connection else you can select the option as activate later. 

17. Now system will reboot automatically and is asked to adjust your monitor settings.  

If  it  does,  you’ll  have  only  an  “OK” box  to  select 

18.After  adjusting  your  display  settings,  you’re  asked  to  hit  OK  to  confirm that you can 

read the display. if display is unreadable the settings should be revent. 
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19. Next it will ask to add users to login in to the system. Here the username should 

not be same as the computer name. 

 

20.Now  click  on  next  to  complete  the  installation  and  click  the  finish  button to restart the 

system. 

 

 

 

 



IT WORKSHOP MANUAL 
 

  
Page 36 

 
  

 

 

 

 

 

 

 

 

 

 

21.Now to boot from the hard disk , at time of the reboot just change the boot  device  

priority  in  the  advanced  BIOS  feature  window  as  the  first boot device priority to hard 

disk and the second boot device priority to  CD. It will now show the standard window 

login screen. 

 

Result: I  have  successfully  completed  the  installation  of  Microsoft  windows  XP on 

a Personal Computer. 
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TASK 4 

OPERATING SYSTEM FEATURES 

Windows XP features: 

Windows XP is an operating system produced by Microsoft for  use on personal computers, including 

home and business desktops, laptops and media centers. First released to computer manufacturers on 

August 24, 2001, it is the second most popular version of Windows, based on installed user base.  

 The name "XP" is short for "EXPerience" highlighting the enhanced user experience.  

Windows XP, the successor to Windows 2000 and Windows ME, was the first consumer-   oriented 

operating system produced by Microsoft to be built on the Windows NT kernel. Windows XP was 

released worldwide for retail sale on October 25, 2001, and over 400 million copies  

During Windows XP's development, the project was codenamed "Whistler", after Whistler, British 

Columbia, as many Microsoft employees skied at the Whistler-Blackcomb ski resort.  

According to web analytics data generated by Net Applications, Windows XP was the most widely 

used operating system until August 2012, when Windows 7 overtook it. As of August 2013, Windows 

XP market share is at 33.66%, having decreased almost every month since at least November 2007, the 

first month for which statistics are publicly available from Net Applications.  

New and updated features: 

1. Windows XP featured a new task-based GUI (Graphical user interface). The Start menu and taskbar 

were updated and many visual effects were added. 

2. A translucent blue selection rectangle in Windows Explorer 

3. Drop shadows for icon labels on the desktop 

4. Task-based sidebars in Explorer windows ("common tasks") 

5. The ability to group the taskbar buttons of the windows of one application into one button, with a 

popup menu listing the window titles 

Graphics: With the introduction of Windows XP, the C++ based software-only GDI+ subsystem was 

introduced to replace certain GDI functions. GDI+ adds anti-aliased 2D graphics, textures, floating 

point coordinates, gradient shading, more complex path management, bicubic filtering, intrinsic support 

for modern graphics-file formats like JPEG and PNG, and support for composition of affine 

transformations in the 2D view pipeline. GDI+ uses ARGB values to represent color.  
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ClearType: Windows XP includes ClearType subpixel rendering, which makes onscreen fonts 

smoother and more readable on liquid crystal display (LCD) screens. Although Clear Type has an effect 

on CRT monitors, its primary use is for LCD/TFT-based (laptop, notebook and modern 'flatscreen') 

displays. ClearType in Windows XP currently supports the RGB and BGR sub pixel structures. There 

are other parameters such as contrast that can be set via a ClearType Tuner powertoy that Microsoft 

makes available as a free download from its Typography website. 

Start menu: IN Windows XP, the Start button has been updated to support Fitt's law. To help the 

user access a wider range of common destinations more easily from a single location, the Start menu 

was expanded to two columns; the left column focuses on the user's installed applications, while the 

right column provides access to the user's documents, and system links which were previously located 

on the desktop.  

Links to the My Documents, My Pictures and other special folders are brought to the fore. The 

My Computer and My Network Places (Network Neighborhood in Windows 95 and 98) icons were also 

moved off the Desktop and into the Start menu, making it easier to access these icons while a number 

of applications are open and so that the desktop remains clean. Moreover, these links can be configured 

to expand as a cascading menu.  

Taskbar: The taskbar buttons for running applications and Quick Launch have also been updated for 

Fitt's law. Locking the taskbar not only prevents it from being accidentally resized or moved but 

elements such as Quick launch and other Desk Bands are also locked from being accidentally moved. 

The Taskbar grouping feature combines multiple buttons of the same application into a single button, 

which when clicked, pops up a menu listing all the grouped windows and their number.  

Advanced taskbar grouping options can be configured from the registry.[6] The user can choose 

to always show, always hide or hide some or all notification area icons if inactive for some time. A 

button allows the user to reveal all the icons. The Taskbar, if set to a thicker height also displays the day 

and date in the notification area. 

Windows Explorer : There are significant changes made to Windows Explorer in Windows XP, 

both visually and functionally. Microsoft focused especially on making Windows Explorer more 

discoverable and task-based, as well as adding a number of features to reflect the growing use of a 

computer as a “digital hub”. 

Navigation pane: The “Folders” button on the Windows Explorer toolbar toggles between the 

traditional navigation pane containing the tree view of folders, and the task pane. Users can also close 

the navigation pane by clicking the Close button in its right corner as well as turn off the task pane from 

Folder Options. 
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The navigation pane has been enhanced in Windows XP to support "simple folder view" which 

when turned on hides the dotted lines that connect folders and subfolders and makes folders browsable 

with single click while still keeping double clicking on in the right pane. Single clicking in simple 

folder view auto expands the folder and clicking another folder automatically expands that folder and 

collapses the previous one. 

Grouping and sorting: Windows XP introduced a large number of metadata properties [7] which 

are shown as columns in the "Details" view of Explorer, in the new Tiles view in Explorer, on the 

Summary tab in a file's properties, in a file's tooltip and on the Explorer status bar when a single file is 

selected. Users also gain the ability to sort by any property which is turned on in "Details" view. 

Developers can write column handler shell extensions to further define their own properties by which 

files can be sorted. The column by which items are sorted is highlighted.  

Search: Microsoft introduced animated “Search Companions” in an attempt to make searching more 

engaging and friendly; the default character is a puppy named Rover, with three other characters 

(Merlin the magician, Earl the surfer, and Courtney) also available. These search companions powered 

by Microsoft Agent technology, bear a great deal of similarity to Microsoft Office’s Office Assistants, 

even incorporating “tricks” and sound effects. 

Image handling in Explorer: Windows XP improves image preview by offering a Filmstrip view 

which shows images in a single horizontal row and a large preview of the currently selected image 

above it. “Back” and “Previous” buttons facilitate navigation through the pictures, and a pair of 

“Rotate” buttons offer 90-degree clockwise and counter-clockwise rotation of images. Filmstrip view 

like any other view can be turned on per folder. Aside from the Filmstrip view mode, there is a 

'Thumbnails' view, which displays thumbnail-sized images in the folder and also displays images a 

subfolder may be containing (4 by default) overlaid on a large folder icon.  

AutoPlay:AutoPlay examines newly discovered removable media and devices and, based on content 

such as pictures, music or video files, launches an appropriate application to play or display the 

content.[11] AutoPlay (not to be confused with AutoRun) was created in order to simplify the use of 

peripheral devices – MP3 players, memory cards, USB storage devices and others – by automatically 

starting the software needed to access and view the content on these devices. AutoPlay can be enhanced 

by AutoPlay-compatible software and hardware. 

Windows Picture and Fax Viewer:Windows XP includes Windows Picture and Fax Viewer 

which is based on GDI+[15] and is capable of viewing image formats supported by GDI+, namely, 

JPEG, BMP, PNG, GIF (including animated GIFs), ICO, WMF, EMF and TIFF format files. It 

supersedes part of the functions of Imaging for Windows in previous versions of Windows.The 

Windows Picture and Fax Viewer is integrated with Windows Explorer for functions like slideshow, 

email, printing etc. and quickly starts up when an image is double clicked in Windows Explorer.  
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TASK 5 

NETWORKING 

Aim: Networking Concepts, Connecting 2 Computers Using Cables, Switches and Wireless 

Technology, crimpling activity 

Networking is the practice of linking computing devices together with hardware and software 

that supports data communications across these devices. 

A computer network or data network is a telecommunications network that allows computers to 

exchange data. In computer networks, networked computing devices (network nodes) pass data to each 

other along data connections. The connections (network links) between nodes are established using 

either cable media or wireless media. The best-known computer network is the Internet. 

Network devices that originate, route and terminate the data are called network nodes.[1] Nodes 

can include hosts such as servers and personal computers, as well as networking hardware. Two devices 

are said to be networked when a device is able to exchange information with another device. 

Computer networks support applications such as access to the World Wide Web, shared use of 

application and storage servers, printers, and fax machines, and use of email and instant messaging 

applications. Computer networks differ in the physical media used to transmit their signals, the 

communications protocols to organize network traffic, the network's size, topology and organizational 

intent. 

1. To connect two computers with a cable: 

This works best if both computers are running this version of Windows. 

1. Plug each end of the crossover cable into a network port on the back of each computer. 

2. On one of the computers that is running this version of Windows, do the following: 

Open Network and Sharing Center by clicking the Start button , clicking Control Panel, 

clicking Network and Internet, and then clicking Network and Sharing Center.  

3. In the network map at the top of Network and Sharing Center, double-click the Unidentified 

network icon. (If you have more than one network, this icon will be labeled Multiple networks.) 

4. If network discovery and file sharing are turned off, in Network, click the Information bar 

containing the following message: "Network discovery and file sharing are turned off. Network 

computers and devices are not visible. Click to change...," and then click Turn on network 

discovery and file sharing.  If you are prompted for an administrator password or 

confirmation, type the password or provide confirmation. 

5. In the Network discovery and file sharing dialog box, select one of the following options: 
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o No, make the network that I am connected to a private network  

o Yes, turn on network discovery and file sharing for all public networks  

The first option is usually the best choice because it only affects the network that you are 

connected to. 

2.How to Connect Two Computers via Ad-hoc Wireless: If both computers have Wireless 

Network Adapters installed, this method allows you to share files, printers, and Internet connection 

without any additional cost. All you need to do is to create a Wireless network on the machine that is 

connected to the Internet and have the other computer(s) connect to this network. You can set up WEP 

security in order to prevent other people in the neighborhood to connect to your network. File/Printer 

sharing and ICS are done the exact same way as an Ethernet network. The maximum bandwidth for 

802.11g networks is 54Mbps, which is slower than USB2.0 and 100Mbps Ethernet, but fast enough for 

most data transfer and Internet sharing scenarios. 

For wireless connections, instead of connecting the computers to the ports on the router, you 

will have to select the wireless network from the list of all available networks. By default, the network 

name is identical to the name of your router (ex. Linksys, Netgear, or Default).  

Crimping tool: A crimping tool is a tool designed to crimp or connect a connector to the end of a 

cable. For example, network cables and phone cables are created using a crimping tool to connect the 

RJ-45 and RJ-11 connectors to the end of the cable. In the below example picture, this crimper is 

capable of crimping a RJ-11 (6-Pin) and RJ-45 (8-Pin) connectors and also includes a wire cutter near 

the handles that can be used to cut phone or CAT5 cable. 

 

To use this crimping tool, each wire is first placed into the connector. Once all the wires are in 

the jack, the connector with wires is placed into the crimping tool, and the handles are squeezed 

together. Crimping makes the plastic connector puncture and hold each of the wires, which prevents the 

wires from falling out and for data to be transmitted from the connector to each of the wires. 
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TASK 6 

BROWSING THE INTERNET: 

Steps for creating a GMAIL account: 

 

1. Open the Gmail website: Click the red “CREATE AN ACCOUNT” button in the top-right 

corner. This will take you to the “Create a new Google Account” page.  

o Creating a Gmail account creates an entire Google account that you can use to access 

other Google products and services. 

2. Come up with a username: Your username will become your new Gmail email address. Have 

a backup or two handy in case your desired name is already taken. If your username is not available, 

you will be given several related options, or you can try a different one. 

http://www.wikihow.com/Image:Create-a-Gmail-Account-Step-2-Version-2.jpg
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3. Fill out the rest of the required information: You will need to enter your first and last 

name, your birthday (for age verification), your gender, your phone number in case you lose access to 

your account, and a verification email address. You also need to enter which country you reside in. 

 

o The mobile phone number is recommended but not required. Google can send you a text 

in case you lose access to your Gmail account. 
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4. Complete the CAPTCHA: This is a verification tool that ensures that a real person is creating 

the account. If you can’t read it, click the refresh button next to the text field to get a new one, or click 

the speaker button to have it read out loud through your computer speakers.  

o After you fill out the CAPTCHA, select your current location. Choose your country of 

residence, even if you’re planning on using the email elsewhere. 

 

Agree to the privacy policy: Take the time to read the entire privacy policy so that you are 

aware of what Google can and can’t do with your personal information. Check the box if you 

agree to Google’s terms.  

5. Choose whether or not you want your +1 information shared:This option will tailor 

the Google +1 icons you see across the web. If you keep the box checked, you will be able to see the 

sites that your friends +1. This service is used to tailor ads to you. 

 

 

6. Click Next Step: This will take you to your Google+ profile creation page. All Google accounts 

create a Google+ account when they are created. You can choose whether or not you would like to add 

a picture to your account.  

http://www.wikihow.com/Image:Create-a-Gmail-Account-Step-5Bullet3-Version-2.jpg
http://www.wikihow.com/Image:Create-a-Gmail-Account-Step-6-Version-2.jpg
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7. Click Next Step once more: Your Gmail account has been created. You can click the button to 

return to Gmail, or visit any other Google service. You should be automatically logged in no matter 

which Google site you visit. 

How to send an email: Email is a great way of getting information to others quickly and easily. 

Being able to send messages to friends and family at the touch of a button keeps you up to date no 

matter where in the world you are. The following steps show you how to send an email using a Gmail 

account. However, many email accounts or applications follow a similar process for creating and 

sending a new message. 

Follow these step-by-step instructions to send an email: 

Step 1: Log in to your Gmail account so that you are on the dashboard (main page) of your mail 

account. 

Step 2: Click Compose. 

Step 3: A new, smaller email window will open up over the inbox. In the ‘To’ box, type in the email 

address of the recipient. 

 

                                

http://www.wikihow.com/Image:Create-a-Gmail-Account-Step-7-Version-2.jpg
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 Step 4: You might want to include someone else in your email to ‘keep them in the loop’. You can do 

this by clicking Cc or Bcc, which will open another field. ‘Cc’ means ‘carbon copy’ and ‘Bcc’ means 

‘blind carbon copy’. Adding an email address to the ‘Cc’ field means that that person will receive a 

copy of the email and all the other recipients will see their email address. If an email address is put into 

the 'Bcc’ field, the person will get a copy of the email but no other recipient will see that address. 

If you are sending the same email to lots of different people, it’s a good idea to put all the email 

addresses in the ‘Bcc’ field to keep your ‘mailing list’ confidential. That way, there’s no chance that it 

could fall into the hands of a spammer or hacker. 

  

 

 

Step 5: The subject field allows you to give the recipient an idea of the topic of your email, like a 

heading. You don’t have to put anything in the subject box, but it can help when viewing and sorting 

email. 

Step 6:  Email text can be formatted in a similar way to text in a word document. You can change the 

font style, colour and size using the formatting icons. You can also create bullet points and check the 

spelling of your email. Click on the underlined A to view formatting options.  
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Step 7: Type your message in the main body field of your email.  

Step 8: When you’re happy with your email, click Send. 

 

  

Step 9: The email you’ve sent will now be stored in the ‘Sent Mail’ folder on your Gmail dashboard. 

 

 

Step 10: You may start an email but then decide to come back to it later rather then sending it 

straightaway. Click Save Now at the top of the email to save the unfinished email to your ‘Drafts’ 
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folder.  When you decide that you’re ready to send it, you can retrieve it from the ‘Drafts’ folder by 

clicking Drafts and then clicking the correct item in the ‘Drafts’ folder list. Finish the email and click 

Send as normal. 

BROWSERS: A browser is software that is used to access the internet. A browser lets you visit 

websites and do activities within them like login, view multimedia, link from one site to another, visit 

one page from another, print, send and receive email, among many other activities. The most common 

browser software titles on the market are: Microsoft Internet Explorer, Google's Chrome, Mozilla 

Firefox, Apple Computer's Safari, and Opera. Browser availability depends on the operating system 

your computer is using (for example: Microsoft Windows, Linux, Ubuntu, Mac OS, among others). 

1.What does my browser do? 

When you type a web page address such as www.allaboutcookies.org into your browser, that 

web page in its entirety is not actually stored on a server ready and waiting to be delivered. In fact each 

web page that you request is individually created in response to your request. 

You are actually calling up a list of requests to get content from various resource directories or servers 

on which the content for that page is stored. It is rather like a recipe for a cake - you have a shopping 

list of ingredients (requests for content) that when combined in the correct order bakes a cake (the web 

page).The page may be made up from content from different sources. Images may come from one 

server, text content from another, scripts such as date scripts from another and ads from another. As 

soon as you move to another page, the page that you have just viewed disappears. This is the dynamic 

nature of websites. 

Major Browsers:  

1. Opera: 

Opera has managed to weather the browser wars since its original release in 1996. Constantly 

innovating, this browser is now a full-fledged Internet suite with web, e-mail, news (usenet and RSS) 

and chat with a wealth of features for new switchers and power users alike. 

Opera also provides a mobile web browser, Opera Mini. In addition to Android and iOS, Opera 

Mini runs on most Java-capable devices, bringing the web to even low-end mobile phones.  

You can sync your bookmarks between Opera Mini and the desktop version of Opera using 

Opera Link. 

 

http://my.opera.com/community/download.pl?ref=Kelson&p=opera_desktop
http://mini.opera.com/
http://link.opera.com/
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2. Firefox: 

Mozilla Firefox has been the most successful alternative web browser since the “browser 

wars” ended. The flagship product of the Mozilla Foundation traces its lineage back to the original 

Netscape. Firefox was designed for simplicity, security, and extensibility, with hundreds of extensions 

available. The Mozilla Thunderbird mail & news client is a perfect companion. Both applications are 

open-source. 

A mobile Firefox is available for Android, iPhone and iPad users, Firefox Home will sync your Firefox 

history, bookmarks and tabs to your phone browser. 

3. Google Chrome: 

In 2008, Google stripped down the web browser to its essentials and rethought basic 

assumptions about what a browser should do. Focused on enhanced performance for web applications, 

Chrome stays out of your way and lets you focus on the web itself. 

Chrome uses the WebKit engine (like Safari) and is similar to the default web browser on the Android 

mobil phone platform. 

4. Internet Explorer : 
      Internet explorer 9 is super fast, and you don't have to have millions of windows open, you can drag 

tabs into other windows. It doesn't crash as much either. 

       IE is the most popular, trusted and reliable web browser of its time. It has the best help and support 

system and has an amazing and fast experience using it. In my opinion Google chrome rules now but IE 

was and is and will be the best and superb browser in its time. 

 

5. UC Browser: 
         The best mobile browser in terms of download speed, graphics, browsing experience, error freed 

sign ups, uniqueness, user interface etc. 

Facebook : It is an online social networking service. Its name comes from the colloquial name for the 

book given to students at the start of the academic year by some American university administrations to 

help students get to know one another. Facebook was founded in February 2004 by Mark Zuckerberg 

with his college roommates and fellow Harvard University students Eduardo Saverin, Andrew 

McCollum, Dustin Moskovitz and Chris Hughes. The founders had initially limited the website's 

membership to students of the University of Harvard, but later expanded it to colleges in the Boston 

area, the Ivy League, and Stanford University. It gradually added support for students at various other 

universities before it opened to high-school students, and eventually to anyone aged 13 and over. 

http://www.mozilla.com/firefox/
http://www.mozilla.com/mobile/
https://www.mozilla.com/mobile/home/
http://www.google.com/chrome
http://en.wikipedia.org/wiki/Social_networking_service
http://en.wikipedia.org/wiki/Facebook_%28directory%29
http://en.wikipedia.org/wiki/Facebook_%28directory%29
http://en.wikipedia.org/wiki/Mark_Zuckerberg
http://en.wikipedia.org/wiki/Harvard_University
http://en.wikipedia.org/wiki/Eduardo_Saverin
http://en.wikipedia.org/wiki/Andrew_McCollum
http://en.wikipedia.org/wiki/Andrew_McCollum
http://en.wikipedia.org/wiki/Dustin_Moskovitz
http://en.wikipedia.org/wiki/Chris_Hughes
http://en.wikipedia.org/wiki/Ivy_League
http://en.wikipedia.org/wiki/Stanford_University
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Facebook now allows anyone who claims to be at least 13 years old to become a registered user of the 

website.  

Skype:  Skype is a voice-over-IP service and instant messaging client that is developed by the 

Microsoft Skype Division. The name was derived from "sky" and "peer". 

Skype was first released in August 2003. It was written by Estonian developers Ahti Heinla, 

Priit Kasesalu, and Jaan Tallinn, Danish Janus Friis, and Swedish Niklas Zennström, who had also 

originally developed Kazaa. Skype had 663 million registered users as of the end of 2010. It was 

bought by Microsoft in 2011 for $8.5 billion. Microsoft's Skype division headquarters is in 

Luxembourg, but most of the development team and 44% of the overall employees of the division are 

still situated in Tallinn and Tartu, Estonia.  

Intranet: An intranet is a computer network that uses Internet Protocol technology to share 

information, operational systems, or computing services within an organization. This term is used in 

contrast to internet, a network between organizations, and instead refers to a network within an 

organization. Sometimes, the term refers only to the organization's internal website, but may be a more 

extensive part of the organization's information technology infrastructure, and may be composed of 

multiple local area networks. The objective is to organize each individual's desktop with minimal cost, 

time and effort to be more productive, cost efficient, timely, and competitive. 

An intranet may host multiple private websites and constitute an important component and focal 

point of internal communication and collaboration. Any of the well known Internet protocols may be 

found in an intranet, such as HTTP (web services), SMTP (e-mail), and FTP (file transfer protocol). 

Internet technologies are often deployed to provide modern interfaces to legacy information systems 

hosting corporate data. 

An intranet can be understood as a private analog of the Internet, or as a private extension of the 

Internet confined to an organization. The first intranet websites and home pages were published in 

1991, and began to appear in non-educational organizations in 1994.  

Intranets are sometimes contrasted to extranets. While intranets are generally restricted to 

employees of the organization, extranets may also be accessed by customers, suppliers, or other 

approved parties. Extranets extend a private network onto the Internet with special provisions for 

authentication, authorization and accounting (AAA protocol). 

In many organizations, intranets are protected from unauthorized external access by means of a 

network gateway and firewall. For smaller companies, intranets may be created simply by using private 

IP address ranges, such as 192.168.0.0/16. In these cases, the intranet can only be directly accessed 

from a computer in the local network; however, companies may provide access to off-site employees by 

using a virtual private network, or by other access methods, requiring user authentication and 

encryption. 

http://en.wikipedia.org/wiki/Voice-over-IP
http://en.wikipedia.org/wiki/Instant_messaging_client
http://en.wikipedia.org/wiki/Microsoft_Skype_Division
http://en.wikipedia.org/wiki/Ahti_Heinla
http://en.wikipedia.org/wiki/Priit_Kasesalu
http://en.wikipedia.org/wiki/Jaan_Tallinn
http://en.wikipedia.org/wiki/Janus_Friis
http://en.wikipedia.org/wiki/Niklas_Zennstr%C3%B6m
http://en.wikipedia.org/wiki/Kazaa
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Luxembourg
http://en.wikipedia.org/wiki/Tallinn
http://en.wikipedia.org/wiki/Tartu
http://en.wikipedia.org/wiki/Estonia
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/Internet_Protocol
http://en.wikipedia.org/wiki/Website
http://en.wikipedia.org/wiki/Local_area_network
http://en.wikipedia.org/wiki/HTTP
http://en.wikipedia.org/wiki/SMTP
http://en.wikipedia.org/wiki/File_Transfer_Protocol
http://en.wikipedia.org/wiki/Internet
http://en.wikipedia.org/wiki/Extranet
http://en.wikipedia.org/wiki/AAA_protocol
http://en.wikipedia.org/wiki/Gateway_%28telecommunications%29
http://en.wikipedia.org/wiki/Firewall_%28networking%29
http://en.wikipedia.org/wiki/Virtual_private_network
http://en.wikipedia.org/wiki/Authentication
http://en.wikipedia.org/wiki/Encryption
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TASK 7 

ANTIVIRUS 

Aim: Install antivirus on a system and check for threats to the computer being used 

Good anti-virus software is important, but even more important is practicing safe browsing habits. The 

best way to avoid viruses is to make sure you don't download them in the first place. Don't click on 

anything that claims its anti-virus software unless you know where it came from. 

Steps to Installing Antivirus 

1. Install the software on each server or PC that has access to the internet. It may not be necessary 

to install the software on other PCs if they access the internet via your main server. 

2. You need to consider remote or mobile workers or workers that use laptop computers. They will 

need the antivirus software installed on their systems too. 

3. Once the above has been achieved, check for updates via the internet. Go to the main menu for 

your software and select updates. If there are any, then it will simply and automatically 

download on to your PC. 

4. The next step is to run the antivirus in order to make sure that there aren’t any viruses or other 

malware on the PCs. 

5. In most packages is it possible to set a time for your software to automatically check for updates 

and then check for viruses. You may wish to set this to weekends or evenings as this activity, 

while working in background and allowing users to continue to work, can still effect the 

performance of your PC or server. 

6. It is important to have a plan in place that helps your organization to react to a virus and 

recover. When putting this plan together you need to ensure the following: 

• Make sure that all servers and PCs have the latest antivirus updates. 

• New viruses are constantly emerging and can spread via the internet extremely quickly so 

keeping your antivirus updated regularly is critical. 

• If your systems are not updated regularly, your organization could be at risk from a virus attack. 

• Make sure that you carry out a virus scan every time you make any changes to your server or 

PC such as adding new software or users. 

• Provide users with instructions on what to do should there be a virus before a relevant update is 

available to the antivirus package. 

• This may include stopping access to the internet and ensuring that no other emails are sent 

internally or externally via the internet. 

• Let your suppliers and organizations that your business is in regular contact with know of the 

incident. 

• Notify your supplier of the antivirus of the issue and they will be able to help. 
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7. Administration training – plan for half a day. You will need to choose an individual to learn 

how to add extra users, download updates and check for viruses. 

8. User training. This is simply to ensure that everyone is comfortable with the antivirus package 

and to help them set it up in order to meet their requirements. 

Pitfalls of Antivirus: 

• Some antivirus packages can slow down the speed of your PC or network. 

• Antivirus software can require a great deal of hard disk and memory. 

• Antivirus software needs to be updated regularly. It is very important that the antivirus software 

is updated, preferably on a daily basis, because new viruses and malware are developed and the 

antivirus vendors will develop counter measures to deal with them. This can be achieved by 

automatically connecting to your supplier’s website via the internet and downloading the 

necessary files. You can normally set this up to happen automatically. 

• Antivirus checks must to be run regularly. Again, ideally you should run your antivirus software 

daily as internet access and email can potentially cause problems. 

• Not all antivirus software is capable of being effective at dealing with viruses, spyware and 

adware so you may need to run two or more packages. However, be sure that you are not 

running two systems that conflict and prevent each other working properly. 
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TASK 8 

MS WORD-2007 

Aim:   Word Processing 

INTRODUCTION:  Word processing is an application program that allows you to create letters, 

reports, newsletters, tables, form letters, brochures, Web pages. Using this application program you can 

add pictures, tables, and charts to your documents. You can also check spelling and grammar.  

MAIN FEATURES OF WORD PROCESSING: 

 

The main features are: 

1. You can create professional documents fast, using built in and custom templates. 

2. You can easily manage large documents using various features like the ability to create table of 

contents, index, and cross-references. 

3. You can work on multiple documents simultaneously 

4. With the help of mail merge, you can quickly create merge documents like mass mailings or mailing 

labels. 

5. AutoCorrect and AutoFormat features catch typographical errors automatically and allow you to use 

predefined shortcuts and typing patterns to quickly format your documents. 

6. The print zoom facility scales a document on different paper sizes, and allows you to print out 

multiple pages on a single sheet of paper. 

7. The nested tables feature supports putting one table inside another table. 

8. You can export and save your word documents in PDF and XPS file format. 

 

STARTING MS WORD PROGRAM: You can start your Word program different ways. One way is 

using Start button: 

 

1. Click on the Start button. 

 

2. In the menu that appears select All Programs Microsoft Office Microsoft Office Word 2007. In 

few seconds you will see Word screen on the monitor. 

 

3. You can also start your MS Word program by double clicking on Microsoft Word icon, which 

lies on the Microsoft Office Shortcut Bar (MOSB). 

 

 WORD SCREEN LAYOUT: The Word screen (Window) contains a number of objects such as Tabs, 

Menus, Sub menus, short-cut commands etc. 

1. Menus: 

The features in Word 2007 display as various tabs such as Home, Insert, Page Layout,References etc. 

To view all sub tasks/options (expanded form) in each menu, you must click the required option.  

Shortcut Menus. 

These features allow you to access various Word commands faster than using the options on the 

menu bar. When the menu is expanded, the shortcut menu is displayed with short-cut command option 



IT WORKSHOP MANUAL 
 

  
Page 54 

 
  

for each of the short-cut menu item. The options on this menu will vary depending on the sub-task that 

was clicked or selected. For example, the shortcut menu on the side is produced by selecting or 

expanding the Border option of the paragraph sub-task of the Home Tab from the Tab bar.  

2. Toolbars: MS Word 2007 provides a customized quick access toolbar to organize the tools available 

for easy and fast access of the commands. Many toolbars displaying shortcut buttons are also available 

to make editing and formatting quicker and easier. The toolbars that are already displayed on the screen 

are checked. To add/modify simply click on the “More Commands” option which will display the 

following menu for customized selection of tools as per your requirement.  

 

3. Rulers: The rulers display horizontal and vertical scales that reflect the width and height of your 

typing area. The horizontal scale is invaluable when you want to quickly set tabs, margins, and indents. 

Select the View tab on the main MS word 2007 screen to be able to select/deselect the Ruler/Gridlines 

and other options. 

 

WORKING WITH TEXT: 

While using Word 2007, there are certain concepts, menu flow, tips, and commands you should 

learn. This section deals with most common word concepts, tips, and commands you should know 

regardless your skills in using Word 2007 program.  

Typing Text: To enter text, just start typing in the text area! As you type the text will appear where the 

blinking cursor is located and will move from left to right. Unlike with a typewriter, you need not press 

ENTER key at the end of each line, the characters automatically shifted to next line. Word continues to 

let your text wrap (move to the next continuous line) around until you are ready to start anew 

paragraph. To break a continuous line and move to a new paragraph, Press ENTER key at the end of a 

paragraph. 

 Inserting Text:  Move the cursor by using the arrow buttons on the keyboard or positioning the mouse 

and clicking the left button where you want to insert the text. The keyboard shortcuts listed below are 

also helpful when moving through the text of a document: Beginning of the line HOME 

End of the line END. 
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Deleting Text: Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace 

will delete the text to the left of the cursor and Delete will erase the text to the right. To delete a large 

Selection of text, highlight it using any of the methods outlined above and press the DELETE key. 

Replacing Text 

To replace text, follow the steps given below: 

1. Select the text to be removed as explained above. 

2. Start typing the new text. Observe that the new text is replacing the selected text. 

You can also replace the text by selecting the text, then deleting it using DELETE key, and then start 

typing new text. 

Formatting Text: Using the Formatting toolbar is the easiest way to change many attributes of text. If 

the toolbar as shown below is not displayed on the screen, select Home Tab. Under Home Tab you can 

select desired Formatting commands under Font, Paragraph subtask as per the diagram given below. 

 

FORMATTING PARAGRAPHS: In Word 2007, a paragraph is any amount of text, graphics, and 

objector other items that are followed by a paragraph mark. A paragraph mark is inserted each time 

while pressing the ENTER key. In order to change the formatting of a paragraph, select the paragraph 

and then apply the formats you want apply. 

 Paragraph formats affect the entire paragraph and new paragraphs keep the formatting of the 

preceding paragraph. Paragraph marks store the format of each paragraph. If the paragraph mark is 

deleted, the text in that paragraph becomes part of the next paragraph. 

 
You can format a paragraph by placing the cursor within the paragraph and selecting Home® Paragraph 

subtask menu and click on the down arrow on the lower right side of the subtask menu. This will 

display the following menu for you to choose the paragraph formatting. 

 

BULLETED AND NUMBERED LISTS: Bulleted lists and Numbered lists are often used to bring 

main points to a reader’s attention. 

 Creating a Bulleted and Numbered Lists 

To create a bulleted or numbered list, use the list features provided by Word.  

1. Click the Bulleted List button or Numbered List button on the formatting toolbar. 
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2. Type the first entry and press ENTER. This will create a new bullet or number on the next line. If 

you want to start a newline without adding another bullet or number, hold down the SHIFT key while 

pressing ENTER. 

 3. Continue to type entries and press ENTER twice when you are finished typing to end the list. 

Use the Increase Indent and Decrease Indent buttons on the formatting toolbar to create lists of multiple 

levels. You can also type the text first, highlight the section, and press the Bulleted List or Numbered 

List buttons to add the bullets or numbers. 

 

COPYING TEXT AND MOVING (CUTTING) TEXT: Part of editing process of text is copying or 

moving text to other locations of your document. You can use the copy and cut commands to avoid 

retyping text in your document.  

 

Copying Text and Moving:  When you copy or cut text, the text is stored in an area of memory called 

clipboard and can be pasted back into the document or into any other document. The last 12 elements 

that were cut or Copied are placed onto Word’s clipboard. You can view the elements on the clipboard 

by selecting Home Clipboard subtask menu command on the menu bar. 

 Place the mouse arrow over each element in the clipboard to view the contents of each Item and 

click on an element to add its contents to the document. Click Paste All to add all of the items to the 

document at once. Click the Clear Clipboard button (the icon with an “X” over the clipboard image) to 

clear the contents of the clipboard. 

 

Moving (Cutting) Text: Moving text means to remove (cut) the selected text from one location and 

insert it in another location. To move text follows the steps given below: 

1. Select the text that will be moved. 

2. Select Home Clipboard sub task menu command on the menu bar, or click the Cut button on the 

standard tool bar, or press CTRL+X keys. This will move the text to a clipboard. 

3. To paste cut text, move the cursor to the location you want to move the text to and select Home® 

Clipboard subtask menu command on the menu bar, click the Paste Button on the standard toolbar, or 

press CTRL+V keys. To move a small amount of text a short distance, the drag-and drop method may 

be quicker. Highlight the text you want to move, 

Click the selection with the mouse, drag the selection to the new location, and release the mouse button. 

 

Copying Text: Copying means to make a copy of the selected text and insert in another location, 

leaving the original text unchanged.  

1. Select the text that will be moved.  

2.Select Home® Clipboard sub task menu command on the menu bar, or click the Cut button on the 

standard tool bar, or press CTRL+X keys. This will move the text to a clipboard. 

3. Choose Home® Clipboard sub task menu command on the menu bar, click the Copy button on the 

standard toolbar, or press CTRL+C keys to copy the text to the clipboard. 

 

PAGE FORMATTING: The page setup options which included paper size and page orientation etc. 

are normally set either by you or by default at the beginning of the opening a new document. These 
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options are available under Page Layout tab and can easily be changed at any time according to your 

needs. 

Page Margins 

There are two methods by which you can change the page margins of your document: (a) using ruler 

and (b) using Page Setup dialog box. 

1. Move the mouse over the area where the white ruler changes to grey. 

2. When the cursor becomes a double-ended arrow, click with the mouse and drag the margin indicator 

to the desired location. 

3. Release the mouse when the margin is set. 

Headers and Footers: A header is text that is added to the top margin of every page such as a 

document title or page number and footer is text added to the bottom margin. Follow these steps to add 

or edit headers and footers in the document: 

1. Select Insert® Header and Footer subtask menu on the main tab bar. Click on the Header or Footer 

option as per the requirement  

2. On selecting Header option, header toolbar will appear and the top of the page will be highlighted as 

shown below  

3. Type the heading in the Header box. You may use many of the standard text formatting options such 

as font face Increase/Decrease Indent - Change the indentation of a paragraph in relation to the side of 

the page. 

Outside Border - Add a border around a text selection. 

Highlight Color - Use this option to change the color behind a text selection. The color shown on the 

button is the last color used. To select a different color, click the arrow head next to the image on the 

button. 

Text Color - This option changes the color of the text. The color shown on the button is the last color 

chosen. Click the arrow head next to the button image to select another color. 

 

LEAVE LETTER 
 

Aim: Write a leave letter to the Principal by using different alignments, correct formats in MS-Word. 

Procedure: 
Step 1: Open MS-Word by click on START button; go to All Programs, then select Microsoft Office 

Word 

2007. 

Step 2: To open a new document, Click on Office Button then select New - > Blank Document 

then click on create option. 

Step 3: Then select TEXT AREA, and then write Leave Letter as a heading, Select the text, click on 

bold Button   to make it bold as “LEAVE LETTER”, and change the font size to 16. 

Step 4: Then write date and place in a format as follows 

DATE: 05/01/2011, 

Puttur. 

Then Select the text and make it right by clicking on right alignment button  
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Step 5: Then write To address as follows and select this text and make it left by clicking on left 

alignment  button 

To 

The Principal, 

Sree Chaitanya College of Engineering, 

L.M.D. Colony, 

Puttur. 

Step 6: Then write Subject according to your letter. And select this text and press tab button for two 

times. 

Step 7: Then write the body of the letter according to your letter. And select this text and make it 

justification by clicking on justify alignment button  

Step 8: Then write “Thanking you Sir,” select this text and make it to center by clicking on center 

alignment Button  

Step 9: Now write the “From address” as follows 

      Yours Faithfully, 

T.Shirishas. 

Then make it right by clicking on Right alignment button  

Step 10: This is the final step in writing leave letter. In this step, we have to save the letter as “leave 

letter.doc” by selecting “Save” option from Office button. Then a prompt window will ask you to write 

a file 

name. Now you have to give the file name and press the save button 

 

OUTPUT:          
                                     Date:24/3/2012, 

Puttur. 

To 

The Principal, 

Sree Chaitanya College of Engineering, 

L.M.D. Colony, 

Puttur. 

 

Sub:Requesting for 5 days leave-Reg 

 

Respected Sir, 

               I T.Shirisha studying B.Tech I year in IT department in your college. As I am going to 

my home on the occasion of Ugadi festival and also to celebrate my birthday on the next day.So I 

kindly request you to grant me leave for 5 days i.e.,24/3/2012-28/3/2012. 

                                                  Thanking You Sir, 

Yours Faithfully, 

T.Shirisha, 

B.Tech I year, CSE Branch. 
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ID CARD 

Aim: Create a Identity Card of your own which contains your own details by using different font styles, 

font colors, alignments and page size as follows 

• Page width=”2.2” 

• Page height=”3.2” 

Procedure: 

Step 1: Open MS-Word by click on START button; go to All Programs, then select Microsoft Office 

Word 

2007. 

Step 2: To open a new document, Click on Office Button then select New - > Blank Document then 

click on create option. 

Step 3: Now click on “Page Layout” from the Menu bar. Then click on Margins then click on Custom 

Margins option. Then the “Page Setup” dialog box appears. In this you find three tabs namely 

“Margins”,”Paper”,”Layout”.Then in the ‘Margins’ tab, make all the parameters like 

Top, Bottom,Left,Right, and Gutter to zero and make Gutter Position to Left. Then in the Page 

tab, change the width and height options to 2 and 3.2 respectively. Then in the Layout tab, make 

the Header and Footer to zero. Now this page is set to the visiting card as follows 

 

Step 4: In the text area type the text as “Sree Chaitanya College of Engineering” then select the text 

and change the font size to 18 and font to bold  and make the text to center by clicking on center 

alignment button  

Step 5: Then in the next line type the texts as “Identity Card”, then select the text and apply the format 

as size 16 and font to Arial Bold. 

Step 6: Draw a box for attesting photo by clicking on the Shapes button from Insert menu. 

Step 7: After that in the next line type all your details as follows: 

NAME: 

FATHER’S NAME: 

…. 

Then select the text and make it to Justify alignment  

Step 8: After that in the next line, type the text as “Principal” and make it to left alignment by clicking 

Left Alignment button. Then press tab for multiple times , then type the text as “Student’s Signature”. 

Step 9: Then go to Page Layout menu - >Watermark then click on Custom watermark. Then Printed 

Watermark dialog box appears, then select Text Watermark radio button and write the “Text” as 
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“SCCE”. 

Step 10: At last we have to save the file as “Identity Card” by clicking on “Save” option from “Office” 

button. 

 

OUTPUT: 
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TASK 9 

PRESENTATION 

Aim: To learn about ms-power point. 

Procedure: PowerPoint is a tool you can use to communicate your ideas effectively through visual 

aids that look professionally designed yet are easy to make. With PowerPoint, you can create slides for 

your presentation in the output you require: blank and white overheads, color overheads, 35mm slides 

or on-screen electronic slide shows. In addition, you can prepare speaker’s notes, print an outline and 

print audience hand outs.  

Starting PowerPoint: To launch PowerPoint, Click the Start Button on the Windows Taskbar, select 

Programs and then click on Microsoft PowerPoint. You might also find the PowerPoint icon on your 

MS Office Toolbar.  

Creating a New presentation: Whether your presentation will be in the form of an electronic 

slideshow, 35mm slides, overhead or just paper print-outs, the process of creating a PowerPoint 

Presentation is basically the same. You can start with a template, a design template or a blank 

presentation. To get to these three basics form, there are three options. 

 

Blank Presentation: The blank Presentation template is a design template that uses the default 

formatting and design. It is useful if you want to decide on another design template after working on the 

presentation content or if you want to create your own custom formatting and design forms. 

To create a new presentation based on the presentation template, select Blank Presentation from 

the PowerPoint startup dialog box and click OK. With PowerPoint already running, you can (1) select 

New from the File menu, click the General tab on the New Presentation dialog box, click the Blank 

Presentation icon and click OK or (2) click the New button on the standard toolbar. The New Slide 

dialog box appears. 

 

Creating Slides: When you create a new presentation using a template (including the Blank 

Presentation template), you start with first and then continue to build the presentation by inserting new 

slides. 

 

Inserting New Slides:  To add a new slides after the current slide in Slide View: 

Choose New Slide from the Insert menu, or  Click the Insert New Slide button on the Standard 

toolbar On the New Slide dialog box PowerPoint gives you a set of available slide layouts, called Auto 

layouts, to choose from. An Auto Layout contains placeholders for titles, Text and objects such as clip 

art ,graphs or tables that you may want to put on a slide.  

You are not limited only by this option. As you will see later in the handout, anything can be 

added to any slide. To create slide, click an Auto layout icon that matches the layout of the slide you 

want to make; the name of the selected Auto layout appears in the lower right side on the dialog box. 

Then click OK and the new slide appears on the screen. 
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Adding Text to Slides: You can insert text on slides by selecting an Auto Layout with text 

placeholders. Text placeholders are formatted for titles and bulleted lists. The text formatting, which 

includes the font, alignment and bullets, depends on the design template you selected.  

 

Adding slide Objects: You can incorporate elements, such as graphics and even sound and video, into 

your slides in one of to ways. Select an Auto Layout containing a placeholder for an object. Some 

placeholders are for specific object such as clip art, graphs, tables, organizational charts or media clips 

while other placeholders are for all type of objects. 

Tables: To inset a Microsoft Word table on a slide: 

Double-click on a Table Placeholder, 

Click on the Word Table Button shown here, or 

Under the Insert menu, choose Picture, then Word table and specify the number of rows and columns 

you want. If you click on the Insert Microsoft word Table button on the standard toolbar, drag on the 

cells to select the number of rows and columns. 

The table appears along with Word’s application menu and toolbars. 

Type the table contents and, when you’re finished, click anywhere else on the slide. To edit the table, 

double-click on it and edit the table using Word tools and menus. 

Clip Art: 

To add Clip Art to a slide: 

Double-click on Clip Art placeholder. 

Under the Insert menu, choose Picture, and then clip art. Click the Insert Clip Art button on the 

Standard toolbar. You can add text with special effects in your slides using Microsoft WordArt. There 

are at least three ways to put word art in your PowerPoint choose object from the insert menu, or 

double-click on an object placeholder. In the Insert Object dialog box, select Create New and chose the 

latest version of Microsoft Word Art from the Object Type list. The WordArt dialog box and menus 

appear. Type the text and click on Update Display. Choose the special effects you want from the 

WordArt toolbar. When you’re done, click anywhere else on the slide. 
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1. CREATING A POWER POINT PRESENTATION ON IT WORKSHOP 

AIM: To Create a Power Point presentation on IT Work Shop College. 

Procedure: 

To open MS-Power Point: 

Click on Start → Program → Microsoft office → Power Point. 

To open a new presentation: 

1. Click on File → NEW [or] Press Ctrl + N. 

2. A list of options (A blank presentation, Design template, Auto Content Wizard and etc) will be 

displayed. 

3. Select the option A blank presentation to open a new presentation. 

Page settings: This option is used to set the size of the presentation, Layout (Portrait/ Landscape), 
width, Height etc. 

1. Click on File → Page setup 

2. A separate Window (Page setup) will be displayed. 

3. Set the Size of the page, Layout, Height, width and etc if necessary. 

4. Click on OK to apply the options. 

To insert New Picture form ClipArt Gallery 

1. Click on Insert → Picture → Clip Art 

2. At the Right Side of the presentation a separate Window (Clip Art window) will be displayed. 

3. Click on GO button which is just beside the search box. It will display all the available clip arts. 

4. Click on the picture which you want to insert. 

5. To search a particular picture, enter the search string in the search box. If it is found it will display 

the file. Then click on the image to insert. 

6. The position of the picture, size of the picture, Color and etc can be done changed by, Right Click on 

the Picture → Format picture. Make the necessary changes which you need from the dialogue box 

displayed. 

Hyperlinks: 

It is used to connect application. 

Select Required text → go to→ Insert→ Hyperlink. 
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To insert New Picture form another file: 

1. Click on Insert→ Picture→From File 

2. A separate dialogue box (insert picture) will be displayed. 

3. Navigate through the dialogue box to select the location of file. 

4. Click on the file (The file which u need).Click on insert button. 

To Color the Background: 

1. Select the slide to which you need to apply the background color. 

2. Click on Format →Background 

3. A dialogue box with various colors will be displayed. 

4. Select the color which you need. 

5. Click on Apply (to apply the color to the current slide} / Apply to All (To apply the same color for 

all the slides). 

To insert tables and charts: 

It is used to insert tables and charts. 

Go to Insert →Click on chart &amp; Table. 

To save the presentation: 

1. Click on File→Save (or) Ctrl + S 

2. Give an appropriate File name, select the location if required. 

3. Click on Save. 

To Exit from power point: 

1. File→Close to close the current presentation. 

2. Click on File→ Exit to close the Application. 

 

Result: - Thus Power Point Presentation on IT Work Shop is created Successfully by using MS-

Power Point. 
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Output:- 

The following are the divisions in IT 

Workshop

⚫ Hardware LAB

⚫ CP LAB

⚫ Basic S/w Applications LAB

Divisions

 

Slide -1     Slide -2  

 

Hardware LAB

⚫ The Hardware Lab  contains all the peripherals 
of the computer. Every component of the 
computer is shown  and a clear explanation is 
given on every component. This helps the 
student to identify various parts of the computer 
and the functionality of each part.

⚫ System Assembling and Dissembling is 
explained to the student and  every student is 
urged to assemble and dissemble the system. 

⚫ Installation of Operating systems, basic 
Hardware troubleshooting  is thought in this Lab.

CP LAB

This lab has thirty systems. The students 

will execute the C - programs on the 

system which were discussed in the 

classroom. This gives a better 

understanding to the student as all the 

programs are executed  by him practically.

 

               Slide – 3     Slides – 4 
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Basic S/w Applications LAB

This lab has thirty systems. The students 

will work on the following basic 

applications

⚫ Microsoft Word

⚫ Microsoft Excel

⚫ Microsoft PowerPoint.

⚫ Basic internet concepts.

Microsoft Word

The following features are covered in MS 
Word

⚫ Formatting Fonts

⚫ Borders & Colors

⚫ Symbols

⚫ Spell Check

⚫ Tables

⚫Mail Merge and etc.

 

                         Slide – 5                    Slides – 6 

 

 

Microsoft Excel

The following features are covered in MS 
- Excel

⚫ Formulae

⚫ Functions

⚫ Sorting

⚫ Relative addresses

⚫ Charts

⚫ Freeze pans and etc.

           

Microsoft PowerPoint

The following features are covered in MS 

PowerPoint

⚫ Slides & Slide Design

⚫ Slide Transition

⚫ Animation

⚫ Clip Arts

⚫Word Art and etc.

 

                             Slide - 7      Slides - 8 

                                     

Basic internet concepts

The following features are covered in MS -

Excel

⚫ Navigations in the Browser

⚫ Creating Mail ID

⚫ Sending & Receiving Mails

⚫ Searching for information and etc.

 

                                                            Slide - 9 
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TASK 10 

MS EXCEL 

Aim:   To Learn About Ms-Excel 

Procedure: 

INTRODUCTION: A spreadsheet is a large sheet having data and information arranged in rows and 

columns. As you know, Excel is one of the most widely used spreadsheet applications. It is a part of 

Microsoft Office suite. Spreadsheet is quite useful in entering, editing, analyzing and storing data. 

Arithmetic operations with numerical data such as addition, subtraction, multiplication and division can 

be done using Excel. You can sort numbers/characters according to some given criteria (like ascending, 

descending etc.) and use simple financial, mathematical and statistical formulas. 

FEATURES OF SPREADSHEETS: 

There are a number of features that are available in Excel to make your task easier. Some of the main 

features are: 

1. AutoSum - helps you to add the contents of a cluster of adjacent cells. 

 

2. List AutoFill - automatically extends cell formatting when a new item is added to the end of a list. 

 

3. AutoFill - allows you to quickly fill cells with repetitive or sequential data such as chronological 

dates or numbers, and repeated text. AutoFill can also be used to copy functions. You can also alter text 

and numbers with this feature. 

 

4. AutoShapes toolbar will allow you to draw a number of geometrical shapes, arrows, flowchart 

elements, stars and more. With these shapes you can draw your own graphs. 

 

5. Wizard - guides you to work effectively while you work by displaying various helpful tips and 

techniques based on what you are doing. 

 

6. Drag and Drop - it will help you to reposition the data and text by simply dragging the data with the 

help of mouse. 

 

7. Charts - it will help you in presenting a graphical representation of your data in the form of Pie, Bar, 

Line charts and more. 

 

8. PivotTable - it flips and sums data in seconds and allows you to perform data analysis and generating 

reports like periodic financial statements, statistical reports, etc. You can also analyze complex data 

relationships graphically. 

 

9. Shortcut Menus - the commands that are appropriate to the task that you are doing will appear by 

clicking the right mouse button. 

 

 

 

. 
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STARTING EXCEL: 

1. Click on (with the help of mouse) the Start button on the Taskbar at the bottom left corner of the 

Screen 

2. Highlight the All Programs item. The program menu will open. 

3. Select Microsoft Office from the list of programs.  

4. Click on Microsoft Excel. 

Symbolically these actions are shown below. 

Select Start→All Programs→Microsoft Office→Microsoft Excel 2007 commands from your menu bar. 

 

EXCEL WORKSHEET: Excel allows you to create worksheets much like paper ledgers that can 

perform automatic calculations. Each Excel file is a workbook that can hold many worksheets. The 

worksheet is a grid of columns (designated by letters) and rows (designated by numbers). The letters 

and numbers of the columns and rows (called labels) are displayed in gray buttons across the top and 

left side of the worksheet.  

The intersection of a column and a row is called a cell. Each cell on the spreadsheet has a cell 

address that is the column letter and the row number. Cells can contain text, numbers, or mathematical 

formulas. 

Selecting, Adding and Renaming Worksheets: The worksheets in a workbook are accessible by 

clicking the worksheet tabs just above the status bar. By default, three worksheets are included in each 

workbook. One can add more worksheet in a workbook also. To do that 

Insert a new worksheet: 

To quickly insert a new worksheet at the end of existing worksheets 

Click the Insert Worksheet tab as shown below  

To insert a new worksheet before an existing worksheet, 

Select the worksheet before which you want to insert a new worksheet then follow steps as 

1. Select Home tab 

2. Click cells Group 

3. Click Insert 

4. Click Insert Sheet 
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To rename a worksheet: 

To rename a worksheet follow the steps as 

1. Right click on the worksheet tab which you want to rename 

2. Select rename from the Pop Up menu 

3. Type new name for the Worksheet  

 

DATA ENTRY: You can enter various kinds of data in a cell. 

1. Numbers: Your numbers can be from the entire range of numeric values: whole numbers (example, 

25), decimals (example, 25.67) and scientific notation (example,0.2567E+2). Excel displays scientific 

notation automatically if you enter a number that is too long to be viewed in its entirety in a cell. You 

may also see number signs (# # # # ##) when a cell entry is too long. Widening the column that 

contains the cell with the above signs will allow you to read the number. 

2. Text: First select the cell in which data has to be entered and type the text. Press ENTER key to 

finish your text entry. The text will be displayed in the active cell as well as in the Formula bar. If you 

have numbers to be treated as text use an apostrophe (‘) as the first character. You cannot do 

calculations with this kind of data entry. 

3. Date and Time: When you enter dates and times, Excel converts these entries into serial numbers and 

kept as background information. However, the dates and times will be displayed to you on the 

worksheet in a format opted by you. 

Data in Series: You can fill a range of cells either with the same value or with a series of values with 

the help of Auto Fill. 
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EDITING DATA: Editing your Excel worksheet data is very easy. You can edit your data by any of 

the following ways: 

1. Select the cell containing data to be edited. Press F2. Use Backspace key and erase the wrong entry. 

Retype the correct entry. 

2. Select the cell and simply retype the correct entry. 

3. If you want only to clear the contents of the cell, select the cell and press Delete key. 

4. To bring back the previous entry, either click on Undo button on standard Toolbar or use keyboard 

shortcuts CTRL+Z. 

 

MODIFYING A WORKSHEET:  Insert Cells, Rows, Columns and Delete Cells 

 

1. Insert blank cells on a worksheet: Select the cell or the range (range: Two or more cells on a sheet. 

The cells in a range can be adjacent or nonadjacent.) of cells where you want to insert the new blank 

cells. Select the same number of cells as you want to insert. For example, to insert five blank cells, you 

need to select five cells. On the Home tab, in the Cells group, click the arrow next to Insert, and then 

click Insert Cells. 

You can also right-click the selected cells and then click insert on the shortcut menu.In the 

Insert dialog box, click the direction in which you want to shift the surrounding cells. 

 

2. Insert rows on a worksheet: Do one of the following: 

l. To insert a single row, select the row or a cell in the row above which you want to insert the new row. 

For example, to insert a new row above row 5, click a cell in row 5. 

2.To insert multiple rows, select the rows above which you want to insert rows. Select the same number 

of rows as you want to insert. For example, to insert three new rows, you need to select three rows. 

3. To insert nonadjacent rows, hold down CTRL while you select nonadjacent rows. 

4. On the Home tab, in the Cells group, click the arrow next to Insert, and then click Insert Sheet Rows. 

 

3. Insert columns on a worksheet: 

l. To insert a single column, select the column or a cell in the column immediately to the right of where 

you want to insert the new column. For example, to insert a new column to the left of column B, click a 

cell in column B. 

2. To insert multiple columns, select the columns immediately to the right of where you want to insert 

columns. Select the same number of columns as you want to insert. For example, to insert three new 

columns, you need to select three columns. 

 

4. Delete cells, rows, or columns: 

1. Select the cells, rows, or columns that you want to delete. 

2. On the Home tab, in the Cells group, do one of the following: 

To delete selected cells, click the arrow next to Delete, and then click Delete Cells. 

To delete selected rows, click the arrow next to Delete, and then click Delete Sheet Rows. 

To delete selected columns, click the arrow next to Delete, and then click Delete Sheet Columns. 

3. If you are deleting a cell or a range of cells, in the Delete dialog box, click Shift cells left, Shift cells 

up, Entire row, or Entire column. 
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5. Resizing Rows and Columns: Set a column to a specific width 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. changes to the desired size that you want. 

Cell, including formulas and their resulting values, cell formats. 

 

FORMULAS AND FUNCTIONS: To manipulate data and to extract useful information from Excel 

worksheets, formulas and worksheet functions play very important role. In Excel, formulas are used to 

calculate results 

from the worksheet data. When there is some change in the data, such formulas automatically calculate 

the updated results with no extra efforts on the part of the user. There is a new feature introduced by 

Excel 2007, which enables you to create formulas which use columns names from a table, when you are 

working with table. This feature helps the user to make formulas much easier to read. 

A formula can have any or all of the following elements Must begin with the 'equal to' = sign. 

Mathematical operators, such as + (for addition) and / (for division) and logical operators such as <, > 

References of cell (including named ranges and cells) Text or Values Functions related to the 

worksheets, for example SUM or AVERAGE 

 The current cell in which you have entered a formula will display the result after the formula is 

completely entered. Also, when you select or click on a cell which is having some formula, the formula 

will appear in the formula bar. In Excel 2007, the formulas are available in the Formulas Tab.  

 

Sum ( ): Adds all the numbers in a range of cells. 

Syntax: SUM (number1, number 2 ...) 

 

Average function ( ): It helps you to get the average of the numbers. It returns the average (arithmetic 

mean) of the arguments. 

Syntax: AVERAGE (number, number2...) 

 

Min function ( ): It helps you to get the minimum of the numbers. Returns the smallest number in a set 

of values.  

Syntax: MIN (number1, number2,...) 

 

 

Max function ( ): It helps you to get the maximum of the numbers. Returns the largest number in a set 

of values.  

Syntax: MAX (number1,number2,...) 

 

CHARTS: 
Column charts: Data that is arranged in columns or rows on a worksheet can be plotted in a column 

chart. Column charts are useful for showing data changes over a period of time or for illustrating 

comparisons among items.  

In column charts, categories are typically organized along the horizontal axis and values along 

the vertical axis. 
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Line charts: Data that is arranged in columns or rows on a worksheet can be plotted in a line chart. 

Line charts can display continuous data over time, set against a common scale, and are therefore ideal 

for showing trends in data at equal intervals. In a line chart, category data is distributed evenly along 

the horizontal axis, and all value data is distributed evenly along the vertical axis.  

 

 
 

You should use a line chart if your category labels are text, and are representing evenly spaced 

values such as months, quarters, or fiscal years. This is especially true if there are multiple series—for 

one series, you should consider using a category chart. You should also use a line chart if you have a 

few evenly spaced numerical labels, especially years. If you have more than ten numerical labels, use a 

scatter chart instead.  

 

Pie charts: Data that is arranged in one column or row only on a worksheet can be plotted in a pie 

chart. Pie charts show the size of items in one data series, proportional to the sum of the items. The data 

points in a pie chart are displayed as a percentage of the whole pie.  

 
 

Bar charts: Data that is arranged in columns or rows on a worksheet can be plotted in a bar chart. Bar 

charts illustrate comparisons among individual items. 

javascript:AppendPopup(this,'xldefDataSeries_2')
javascript:AppendPopup(this,'grdefDataPoints_3')
javascript:AppendPopup(this,'grdefDataPoints_3')
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 Area charts: Data that is arranged in columns or rows on a worksheet can be plotted in an area chart. 

Area charts emphasize the magnitude of change over time, and can be used to draw attention to the total 

value across a trend. For example, data that represents profit over time can be plotted in an area chart to 

emphasize the total profit. By displaying the sum of the plotted values, an area chart also shows the 

relationship of parts to a whole. 

 
  

XY (scatter) charts: Data that is arranged in columns and rows on a worksheet can be plotted in 

an xy (scatter) chart. Scatter charts show the relationships among the numeric values in several data 

series, or plots two groups of numbers as one series of xy coordinates. 

A scatter chart has two value axes, showing one set of numerical data along the horizontal axis 

(x-axis) and another along the vertical axis (y-axis). It combines these values into single data points and 

displays them in uneven intervals, or clusters. Scatter charts are commonly used for displaying and 

comparing numeric values, such as scientific, statistical, and engineering data.  

 

 
 

Stock charts: Data that is arranged in columns or rows in a specific order on a worksheet can be 

plotted in a stock chart. As its name implies, a stock chart is most often used to illustrate the 

fluctuation of stock prices. However, this chart may also be used for scientific data. For example, 

you could use a stock chart to indicate the fluctuation of daily or annual temperatures. You must 

organize your data in the correct order to create stock charts. 
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The way stock chart data is organized in your worksheet is very important. For example, to create a 

simple high-low-close stock chart, you should arrange your data with High, Low, and Close entered as 

column headings, in that order.  

 

 
 

Surface charts: Data that is arranged in columns or rows on a worksheet can be plotted in a surface 

chart. A surface chart is useful when you want to find optimum combinations between two sets of data. 

As in a topographic map, colors and patterns indicate areas that are in the same range of values. 

You can use a surface chart when both categories and data series are numeric values. 
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MARKS SHEET 

 
Aim: Create a marks sheet for 10 students using EXCEL. 
Steps: 

1 Open MS-EXCEL by clicking on START Button, go to Programs then click on Microsoft Office then 

select Microsoft Office Excel 2007. 

2 Write the title name is Sree Chaitanya College of Engineering at (A1 address) 

3 Write the sub title name is I.B.Tech IT MARKS SHEET at (A2 address). 

4 Now write the requirements fields for calculation of marks, like S.No,H.T.No,subjects,Grand Total & 

Percentage from A3 to O3 cells as follows 

5 Write S.no’s from 1-10 in A4 - A13 cell addresses and H.T.No’s from B4- B13. 

6 Now enter the marks in C4 – M13 cell addresses. 

7 Now in the G.Total cell,select N4 cell and apply the formula for adding the marks contained in C4 – 

M4 cell addresses in the formula bar as 

fx= C4+D4+E4+F4+G4+H4+I4+J4+K4+L4+M4 then press ENTER key. 

8 Select the N4 cell and drag towards down for further students calculations. 

9 Now calculate the Percentage.For that select O4 cell and type % calculation formula in Formula bar 

as 

fx=N4/1000*100 

10 Select the O4 cell and drag towards down for further students results. 

11 Now the % appears in decimal values,now in order to appear the values as rounded values,select the 

O4 

cell then right click the mouse button , select Format cells then Numbers and now make decimal places 

to 0(zero) then click OK.Now again drag for other cell values to be rounded. 

12 Now for keeping the borders,select cells from A1 – O13 and select All Borders on the home Menu. 

13 Now for saving click on OFFICE button and click on Save and type file name as “Marks Sheet”,then 

Click 
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OUTPUT: 

S.NO REG NO PHY  CHE  SOC ENG TEL M1 CPLAB PHYLAB CHEMLAB ITWS LAB ELC LAB G.TOT % 

1 40104201 60 78 50 90 40 67 86 72 70 67 70 750 68.18182 

2 40104202 75 60 45 85 90 66 70 69 51 46 67 724 65.81818 

3 40104203 52 62 63 67 49 78 58 97 91 58 80 755 68.63636 

4 40104204 72 43 51 47 34 58 97 78 58 72 65 675 61.36364 

5 40104205 76 62 68 38 68 52 76 65 54 78 58 695 63.18182 

6 40104206 75 62 56 80 74 52 84 75 65 80 62 765 69.54545 

7 40104207 74 85 71 72 65 68 82 91 64 82 59 813 73.90909 

8 40104208 53 65 62 68 70 75 69 79 90 90 72 793 72.09091 

9 40104209 85 65 78 65 89 59 65 92 98 99 69 864 78.54545 

10 40104210 75 45 59 67 81 68 87 72 71 68 71 764 69.45455 
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TASK 11 

LATEX 

INTRODUCTION: 

LaTeX is a family of programs designed to produce publication-quality typeset 

documents. It is particularly strong when working with mathematical symbols. The history of LaTeX 

begins with a program called TEX. In 1978, a computer scientist by the name of Donald Knuth grew 

frustrated with the mistakes that his publishers made in typesetting his work. He decided to create a 

typesetting program that everyone could easily use to typeset documents, particularly those that include 

formulae, and made it freely available.  

The result is TEX. Knuth's product is an immensely powerful program, but one that does 

focus very much on small details. A mathematician and computer scientist by the name of Leslie 

Lamport wrote a variant of TEX called LaTeX that focuses on document structure rather than such 

details. 

Required Components of LaTeX Document: Every LaTeX document must contain the following 

three components. Everything else is optional (even text). 
1. \documentclass{article} 

2. \begin{document} 

3. \end{document} 

LaTeX Document Structure: 

1.Page Numbering and Headings: The command \pagestyle controls page numbering and 

headings. It should always go between the \documentclass{article} and the \begin{document} 

commands. It can take the following forms: 

A. \pagestyle{plain} is the default, which puts the page number at the center 

of the bottom of the page and provides no headings. 

B. \pagestyle{empty} provides neither page numbers nor headings. 

C. \pagestyle{headings} will provide page numbers and headings from any 

\section's that you are using. 

D. \pagestyle{myheadings} will provide page numbers and custom headings 

2.Creating a Title Page: The title, author, and date of your document are information that 

various LaTeX commands can make use of, if you provide it. 

E. \title{yourtitlehere} 

F. \author{yournamehere} 

G. \date{currentdate} 
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3.Sections: LaTeX is a language for creating structured documents. One of the most important 

ways of creating structure in a document is to split it into logical sections. If your document 

deals with more than one concept or theme, then each concept should go into its own section. 

There are two related commands for creating sections: \section{sectiontitle} and 

\section*{sectiontitle}. he _rst one numbers the sections, while the starred form does not. Both 

create separate sections with titles in a larger font size; they also provide information to LaTeX 

in case you want to create a Table of Contents. 

1. Cross References: 

i. If  you  wish  to  have  cross-references  in  a  document  with  numbered  

sections,  use 

ii. \label{name} to label the point in your document with some mnemonic, and 

Section 

iii. \ref{name} to refer to that point. \ref{name} will be replaced by the 

number of the section containing the corresponding \label command. 

2. Table of Contents: 

i. For a large document, it is a kindness to your reader to provide a Table of 

Contents. If you have been using \section commands throughout your 

document, then LaTeX has all the information that it needs to construct 

one for you. Place the command 

ii. \tableofcontents after your \begin{document} command. 

3. Abstracts: 

i. To create an abstract, place your text in an abstract environment, i.e., between 

ii. \begin{abstract} and \end{abstract} commands. The abstract should 

come immediately after your \maketitle command, but before any 

\tableofcontents command. 

Mathematical type settings: 

Mathematical formulas:There are two ways to insert mathematical formulas into your document with 

LaTeX. One is to have it appear in a paragraph with text. In doing so, the formulas will be compressed 

vertically: limits for integrals and summations will appear to the side instead of on the top and bottom, 

etc. The other way is to have them appear in a separate paragraph, where there will be more room 
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Greek Letters: 
 

    

 

Exponents and Subscripts: 

Use the ^ character (shift-6), known as a caret, to create exponents 

  $x^2$ produces x2 

If you have an exponent containing more than one character, group the 

exponent characters inside braces. 

Above and Below: 

It is useful to be able to draw horizontal lines and braces above and below parts of a 

formula. We can combine the \overline, \overbrace, \underline, and \underbrace 

commands to our heart's content. 
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Fractions: 

Fractions can be written in two ways: with a diagonal fraction bar or a horizontal one. 

Diagonal fraction bars work best in tight places, such as in a text paragraph or when in a larger 

fraction. 

$a/b$ becomes a=b 

The horizontal bar is clearer when you have more room, such as in a formula paragraph. The 

command is a little more complicated, because the numerator and denominator are often 

complicated themselves. A horizontal bar fraction is written as   

\frac{numerator}{denominator}. 

 
 

Functions: LaTeX uses italics in math mode for variables to make them stand out, but Roman (non-

italic) for function names. How is LaTeX to know the di_erence between \sin" as function name and 

\sin" as the product of the variables s, i, and n? Use a backslash in front of \sin" and other function 

names to let LaTeX know that you want the function, not the product of variables. Here is a list of 

function names: 

Sums, Integrals, and Limits: 

Summations and integrals both have lower and upper limits, and the commands are 

similar. Limits usually have text with an arrow placed below them. 
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Text in Math Display: There will be times when you want to include Roman, i.e., non-

italicized words amongst your mathematical symbols. The font isn't the only problem; spacing is 

di_erent between letters in a word and variables in a formula. Use the command 

 

\mbox{your text here} to include short phrases in a formula. 

 

 

Operators: You will probably not need most of the binary operators listed here, but it should be  

handy reference: 

 

Relations: Again, here are more relations than you will ever need. You may want to print this for 

reference. 
 



TASK 11 

UBUNTU OPERATING SYSTEM

venkat
Typewritten text
INSTALLATION STEPS

venkat
Typewritten text
1. Download an Ubuntu Image.2. Create a Bootable USB stick.3. Boot from USB flash drive.4. Installation Setup.5. Drive Management.6. (Optional) Enable Encryption.7. Choose your Location.8. Create Your Login Details.



TASK 12

LINUX COMMANDS

venkat
Typewritten text
Description

venkat
Typewritten text
To Enable vi editor to Practice Linux commands like crate file,Directory, Display the contents in directory, List the contents in directory, mount the file system and delete the file system.
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